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Pro Tools HD 7.0 on Macintosh 
for Pro Tools|HD and Pro Tools|HD Accel Systems on Mac OS X 10.4 
(“Tiger”) Only

Introduction
This Read Me documents compatibility details, known issues, error codes, and corrections to the guides for Pro Tools HD 7.0 
on Digidesign-qualified Macintosh systems running a Digidesign-qualified version of Mac OS X. For the latest compatibility 
information, visit the Digidesign Web site (www.digidesign.com/compato). 

Compatibility
Digidesign can only assure compatibility and provide support for Digidesign-qualified hardware and software configurations. 
For a list of Digidesign-qualified computers, operating systems, and third-party devices, refer to the latest compatibility in-
formation on the Digidesign Web site (www.digidesign.com).

Database File Compatibility

Pro Tools 7.0 requires a new Digidesign database file format. Existing database files will be deleted upon launching 
Pro Tools 7.0 for the first time. Please re-index your drive(s) for faster searches. DigiBase Pro catalog files will not be deleted, 
but have to be updated. Launching Pro Tools will post a dialog allowing you to convert or delete existing catalogs. 

Pro Tools Cannot Record To Drives Formatted as Case-Sensitive (Item #66749)

Pro Tools cannot record to Mac OS X drives which have been formatted as “Case-Sensitive.” Please format the Mac OS X 
record volumes as “Mac OS X Extended (Journaled)” in order to record properly.

Digidesign SCSI|128, ATTO EPCI-UL3D Configuration Tool

If you have either the Digidesign SCSI|128 or ATTO EPCI-UL3D SCSI host bus adapters installed in your system, you should 
use the ATTO Configuration Tool to verify you have the correct drivers, firmware and settings. Instructions can be found in 
the Read Me file contained in the ATTO Utilities folder that is installed to the Applications/Digidesign folder by the Pro Tools 
Installer.
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Known Issues
The following sections document known issues you may encounter when using Pro Tools 7.0, along with workarounds if 
they exist.

Pro Tools

Hardware Buffer Size Mismatch with CoreAudio Driver (Item #68575)

Logic users may experience distorted audio during playback using the CoreAudio Driver under certain conditions. For exam-
ple, if iTunes is running in the background when Logic is launched, the CoreAudio Driver can incorrectly handle the Hard-
ware Buffer size. Audio will sound slow and distorted if this occurs. To fix this, you will need to change the Hardware Buffer 
size that Logic is using to a different one. For example, if the buffer size in Logic is set to 512 on startup, change the buffer 
size to 1024. The audio will no longer be distorted. 

Software Instrument Does Not Emit Sound when Inserted on an Instrument Track or Auxiliary Input (Item #65797) 

Some software instruments will not emit sounds and will not play unless they have a valid hardware input or MIDI output 
assignment. If this occurs, manually assign a hardware input to the Instrument track or Auxiliary Input, and/or manually as-
sign a MIDI output to the Instrument.

Audio Interfaces Connected to Cards 5–7 at 176.4 kHz/192 kHz (Item #67475)

The 176.4 kHz and 192 kHz sample rates support a maximum of four HD Accel or HD Process cards. To use these sample rates, 
any extra I/O interfaces must be removed from the Pro Tools system. 

To reconfigure:

1  Power down the computer and interfaces

2  Remove DigiLink and Loop Sync/Word clock connections from all interfaces connected to HD cards #5 and higher. 

3  Be sure to reconfigure Loop Sync and Word clock connections on the supported interfaces.

4  Start up your computer and launch Pro Tools. You may then use the 176.4 kHz or 192 kHz sample rates on your Pro Tools 
system.

Declaring Legacy Peripherals (Item # 68381)

In certain I/O configurations, after declaring legacy peripherals in the Hardware Setup dialog, the legacy peripherals may not 
appear in the I/O Setup dialog. They will appear after you quit and re-launch Pro Tools.

Changing Settings on Legacy Peripherals (Item #69070)

In some hardware configurations after using Pro Tools at sample rates higher than 48 kHz, some legacy peripherals may not 
be identified and peripherals settings won't be modifiable in the Hardware Setup dialog, although such peripherals can be 
used in the session. If this occurs, un-declare legacy peripherals in the Hardware Setup dialog and declare them again.

G5 Performance Optimizations (Item #63888)

Please uncheck the “Put hard disks to sleep when possible” checkbox and set Processor Performance to “Highest” (located un-
der the Options Tab) in order to optimize Pro Tools performance on Mac OS X 10.4.

Pro Tools is Not Compatible with Surround Audio in QuickTime Movies (Item #67350, 67351, 67353)

QuickTime 7 introduced the ability for QuickTime movies to have surround audio. Currently, Pro Tools is not compatible 
with QuickTime movies that have more than two channels of audio. Pro Tools cannot import from, or bounce to, multi-
channel QuickTime movies. Also, the audio in multi-channel QuickTime movies is not recognized in the Workspace browser.
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AudioSuite and Region Groups (Item #64410)

AudioSuite plug-ins handle Region Groups slightly differently than audio files. With audio files, an AudioSuite process can 
be applied to all copies of a unique Audio file which appear in your session by selecting your target as Region List in the Au-
dioSuite plug-in window and selecting Use in Playlist. However, if your target is set to Region List in the AudioSuite plug-in 
window while you have a region group selected, Pro Tools does not recognize the Region Group as processable audio and will 
present a No Audio Was Selected error. This is because a Region Group is not treated as audio until it is actually used in a track.

To apply an AudioSuite process to all copies of a Region Group in a session at once, do the following:

1  Select the Region Group to be processed.

2  From the Region menu, select Ungroup All. All elements of the group will remain selected.

3  Perform AudioSuite processing.

4  From the Region menu, select Regroup.

When prompted, select Modify to apply the AudioSuite process to all copies of the Region Group in the session, or select 
Copy to apply it only to the selected Region Group.

Burning CDs with iTunes while Pro Tools Is Running (Item #55192) 

It is possible that Pro Tools will crash when you are simultaneously burning a CD with iTunes. Quit Pro Tools before burning 
CDs with iTunes.

Accessing Playback Engine after Opening a Recovered Session (Item #54319)

A recovered session from the Session File Backups folder must first be saved with a new session name before it is possible to 
access the Playback Engine dialog.

Opening a Session with a QuickTime Movie as a Non-Administrator User Can Prevent the Movie from Playing Back 
(Item #47053)

If you open a session as a non-administrator user and you do not have permissions for the QuickTime movie file, Pro Tools 
will tell you that the movie file cannot be found and prompt you to relink. In the relink window the movie can be found and 
Pro Tools will appear to relink to it but it will still not play back. For correct playback, make sure you have permission to use 
the QuickTime movie file.

Maximum Playback Engine Settings for 44.1/48 kHz Sessions with Pro Tools|HD Accel Configurations (Item #42161)

In 44.1 kHz or 44 kHz sessions on Pro Tools|HD systems, setting the Playback Engine to “Max Voice (192 voices)” and DAE 
Playback Buffer to “Level 8” (which will allocate 300 MB of memory), may cause a kernel panic at startup. This problem will 
only occur if the Playback Engine and DAE Playback Buffer are set to this configuration upon initial launch of Pro Tools. The 
workaround is to first launch Pro Tools (but do not open any session), and set the Playback Engine to another combination 
(such as 192 voices with a DAE Playback Buffer of 4). Press OK in the Playback Engine dialog so that those settings are saved 
with other system preferences, and then change the Playback Engine back to 192 voices and the DAE Playback Buffer set to 
Level 8.

Compacting Large Numbers of Selected Regions (Item #40541) 

Compacting all selected regions in a large session may result in the following error: “Assertion in Cmm_Interval.cpp, line 
103.”  If this situation occurs repeatedly for a particular session, the workaround is to use the File > Save Copy In command 
to save the session onto another drive and try again.

“You Do Not Have the Necessary Access Privileges (–5000)” Error During Import (Item #33092)

If you encounter an error when importing media files (audio or video) stating that you do not have the necessary access priv-
ileges, you will need to quit Pro Tools and change the permissions of the files. To change permissions for one or more files, 
switch to the Finder, select the files, choose File > Get Info, click the Owner and Permissions tab, and select your username 
from the Owner pop-up menu. You may need to click the Lock icon and authenticate your username to change Ownership.
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Pro Tools 7.0 Information Is Lost When Saving a Session in a Lower Version of Pro Tools (Item #49923)

When saving a Pro Tools 7.0 session in 5.1-->6.9 format, only those attributes supported by that lower format will be main-
tained when the session is opened using a lower version of Pro Tools. For example, when saving a Pro Tools 7.0 session to 
Pro Tools 5.1-->6.9 format and then opening the session under Pro Tools 6.9, Instrument tracks will be split to corresponding 
MIDI and Auxiliary Input tracks. See the Pro Tools Reference Guide for more information on compatibility and session transfer. 

Pro Tools 7.0 MP3 Codec Exports Non-Copyright Files Only (Item #68985)

The new MP3 codec in Pro Tools 7.0 does not have the ability to encode an attribute for the file to be copyrighted. This is a 
limitation of the new codec from Fraunhofer. 

Delay Compensation

Diminished Audio Record and Playback Performance while Using Delay Compensation (Item #46346)

Delay Compensation requires a substantial amount of system resources, especially when recording in large sessions. If you 
encounter DAE error –9073 when Delay Compensation is enabled, turn Delay Compensation off to free system resources.

DigiBase

Editing File Comments from the Workspace Browser (Item #34160)

In the Workspace Browser, when you enter or edit text in the File Comments column you may encounter an error message 
and lose the changes to the text. If this occurs, enter the text a second time for the change to take effect.

“File Is Busy (–47)” Error in the Task Window (Item #22832)

When attempting to delete a file for which you do not have permissions, you will encounter a “File is busy (–47)” error in the 
Task Window and you will not be able to delete the file. You cannot delete a file or directory for which you do not have Read 
and Write permissions.

Out of Memory (–108) Error (Item #27391)

If you attempt to update the index on a volume with little or no disk space, you will encounter an “Out of memory (–108)” 
error.

Plug-Ins

Demo Mode with 7.0 Plug-Ins and Software Options

Digidesign 7.0 plug-ins and Pro Tools 7.0 software options no longer include time-limited demos. Instead, plug-in and option 
demos require an iLok USB Key and an iLok license for evaluation. If you would like to obtain a demo license, please visit the 
individual product pages located on the Digidesign Web site (www.digidesign.com) and click on the Demo button.

Sluggish Meters with SurroundScope or Waves C4 Plug-In Windows Open (Item #40317) 

When SurroundScope or Waves C4 plug-in windows are open, Pro Tools meter and window movement performance may be 
sluggish. The workaround is to increase the CPU Usage setting to improve performance.

Song Position Pointer Messages Are Not Received in “Continuous Scroll with Playhead” Mode (Item #54587)

When in “Continuous Scroll with Playhead” mode, Synchronic, Intakt (Native Instruments) and other MIDI-enabled plug-
ins stop receiving Song Position Pointer messages, and cannot catch up when starting and stopping playback.

–9128 Errors When Using DigiRack ReWire with Reason (Item #35934)

Depending upon the speed of your CPU, you may need to set the Pro Tools CPU Usage setting to 70% or more to avoid –9128 
errors when using dense sequences from Reason.
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Pro Tools Reports a “Critical Error!” Dialog on Launch on Systems with Emagic’s Logic Platinum Installed (Item #36994)

If Emagic’s Logic Platinum software is installed on the same system as Pro Tools, you may encounter the following two warn-
ings when launching Pro Tools:

• Critical Error! Dialog “A critical error occurred while registering with StreamManager. The ESB will not work properly. 
Please check your StreamManager installation.”

• Critical Error! Dialog “A critical error occurred while registering with StreamManager. The EXS24 will not work properly. 
Please check your StreamManager installation.”

Pro Tools performance is not affected, and these warnings can be ignored. To prevent them from appearing in the future, re-
move the plug-ins called “EXS24 TDM OSX” and “ESB TDM OSX” from your system before launching Pro Tools LE. The plug-
ins are located in the Library/Application Support/Digidesign/Plug-Ins folder.

Control Surfaces

Downloading Firmware for D-Control or D-Command (Items #46015, #46990, #58102)

While downloading firmware updates on D-Control or D-Command, do not adjust any controls in the main unit’s monitor-
ing section, or transfer files on your computer. Doing so may interfere with a successful firmware download.

Resetting Plug-In Parameters from D-Control or D-Command (Item #62263)

You can now reset plug-in parameters from D-Command or D-Control using standard Pro Tools keyboard shortcut keys and 
touching the encoder mapped to that parameter. On Windows, hold the Alt key while touching the encoder for the param-
eter you want to reset; on Macintosh, hold the Option key while touching the encoder for the parameter you want to reset. 

Link Track and Edit Selection from D-Control or D-Command (Item #67090)

D-Control and D-Command support the Link Track and Edit Selection command. On D-Control, configure this option from 
the Soft Keys section, Operations switch, page 3. On D-Command, configure this option in the Console Prefs section, Oper-
ations switch, page 3. 

Shortcuts for Zooming on D-Control or D-Command

D-Control and D-Command now support the following: 

To zoom in on the current selection:

■ Alt-press (Windows) or Option-press (Macintosh) the Zoom switch. 

To zoom out to show the entire session:

■ Double-press the Zoom switch. 

Sends F-J Cannot be Displayed in Channel View on Command|8 (Item #70342)

On Command|8, when you use Channel View to display the sends on a single Pro Tools channel, you can only view Sends 
A-E. To view Sends F-J, use Console view. Press the Send switch to put Command|8 into Sends view, then hold the Shift/Add 
switch and press the corresponding Send Position switch (A=F, B=G, C=H, D=I, E=J). 
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MIDI

Problems when Using Virtual Instruments for MIDI Click (Item #43057)

When using a virtual instrument for a MIDI click, the instrument does not play during Wait for Note. Additionally, the first 
click does not sound. The workaround is to assign the Click to a different MIDI instrument, or use the Click plug-in.

Wait for Note May Not Work with Duplicated Tracks that Contain a Default Program Change (Item #40140) 

In certain instances, the Wait for Note feature will not work correctly with duplicated tracks that have a default program 
change. If this problem occurs, create a new MIDI or Instrument track with the same settings, and the Wait for Note feature 
will work correctly.

Latency When Recording MIDI Tracks with Wait for Note and a Virtual Instrument (Item #43068)

When recording a virtual MIDI Instrument track in Wait for Note mode, latency occurs at Bar 1|Beat 1.

Synchronization and Machine Control

Recording with Serial Time Code (Item #64636)

Occasionally, it is possible for the Tascam DA-98 servo lock bit behavior to cause Pro Tools to think the DA-98 is servo locked 
before it actually is. This could cause a synchronization offset when Pro Tools locked to serial time code generated from a DA-
98. Pro Tools will now handle these cases, but if you experience this problem, try increasing the amount of frames to 10 in 
the “Delay before locking to Timecode” preference. 

Colin Broad Controller in Fan-Out Configuration with Colin Broad Controlling a VTR Requires Specific Settings for Consistent 
Lock Times (Item #59796)

Using the Colin Broad in a fan-out configuration where a linear VTR is an active slave requires the following settings to yield 
consistent lock-up times:

1  Make the tape machine the master in the Edit group.

2  Change the Colin Broad setting Menu 21 to “Input lock tally from – Master.”

3  Optimize Pro Tools Machine Control pre-roll setting for your workflow and track count.

Tamura Controller Punches Pro Tools in Four Frames Early (Item #51496)

The Tamura edit controller punches Pro Tools in four frames early. You can correct this by setting the Sync Offset to 
–00:00:00:04 in the External Time Code Offsets section of the Session Setup window (Setup > Session).

Soundmaster Controller May Not Update Picture Fast Enough with SSL Console (Item #52394)

When rewinding and fast-forwarding from an SSL console connected to a Soundmaster controller, Pro Tools may not update 
the picture fast enough. This may be a Soundmaster settings issue. Make sure the Self Goto Rate value setting on the Sound-
master controller is set to zero. (See your Soundmaster documentation for more information.)
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Video

Last Recorded Video File Cannot Be Deleted (Item #:58642)

Pro Tools does not let you delete the last video file recorded while the current session is open. The workaround is to close the 
session and then delete the file. 

Unrecognized Movies in Pro Tools (Item #46792)

QuickTime and DV movies can lose their .mov or .dv suffix in Mac OS X when transferring a movie from OS 9. If a Pro Tools 
session contains a movie that has lost its suffix, the movie will not be recognized as a valid file by Pro Tools and will not be 
opened. To work around this, close the session, manually add the .dv or .mov suffix to the movie, and then re-open the ses-
sion.

General Localization 

Pro Tools Asian Version Cannot Launch on English OS (Item #59794)

When your computer OS is set to English, you cannot launch the Japanese, Korean or Simplified Chinese Localized version 
of Pro Tools. Attempting to do so will result in the following message: “To run Japanese version of Pro Tools, the Finder's sys-
tem preferences International settings must be set to Japanese. Please refer to Digidesign's documentation for more informa-
tion.” The workaround is to launch the Asian Localized application and change the languages setting of the Finder to the ap-
propriate Asian language.

Error Messages

Error –5000 (Unknown Error) when Launching Pro Tools (Item #36130)

On a system with multiple partitions, if different Interlok Pace versions are installed on different partitions, Pro Tools will re-
port an “Unknown –5000 error” on launch. To avoid this problem, install the same Pace components on all partitions on 
your system.

Error –6031 During Playback (Item #32637)

If you encounter a –6031 error while playing back a session with especially dense MIDI or automation, try increasing the 
Hardware Buffer Size. You may also need to stop playback, save and close the session, quit and re-launch Pro Tools, and re-
open the session before resuming playback.

Error –6042

If you repeatedly encounter –6042 errors, open the System Usage window and check the PCI gauge. If the gauge is peaked, 
you will need to reset the PCI bus. To reset the PCI bus, make all tracks inactive and start playback. If you still encounter a 
–6042 error, quit and relaunch Pro Tools, open the Playback Engine dialog, and change the Number of Voices to a setting that 
uses fewer voices per DSP. 

Error –6074 When Toggling All Plug-Ins Between Active and Inactive Mode During Playback (Item #55049)

In large sessions, deactivating and reactivating all plug-ins simultaneously can cause Pro Tools to post the following error: 
“The engine DSP ran into the TDM2 deadband. Too many I/Os to the TDM2 chip (–6074).” To resolve the problem, activate 
and deactivate plug-ins in smaller groups.

Error –6074 when Running Pro Tools|HD Accel in 32-bit PCI Expansion Chassis (Item #41705)

For best performance when running Pro Tools|HD Accel hardware in 32-bit chassis configurations, use Playback Engine sizes 
of 5 DSP, medium voices, or less. Switching between 48 kHz and 192 kHz (or lower) while running a Playback Engine size of 
6 DSP, max voices, can result in DAE error –6074 and Pro Tools auto-quitting. The auto-quit is not a crash, it is simply an ac-
cidental rapid quit by Pro Tools.
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DAE Error –9073 when Recording to a FireWire Drive and the 2 GB File Limit is Reached (Item #42611)

When the 2 GB file limit is reached during recording to FireWire drives, a –9073 error is posted instead of the expected “Re-
cording has been terminated because a disk is full” dialog. This error is benign, and does not signal any data loss or problem 
with the hard drive.

DAE Error –9073 other than when Recording to a FireWire Drive and the 2 GB File Limit is Reached

If you encounter a –9073 error, refer to the Answerbase for possible causes and solutions (http://answerbase.digidesign.com).

DAE Error –9128

In sessions with high sample rates (96 kHz or higher), you may need to set the Hardware Buffer Size to 512 or more to avoid 
–9128 errors during playback with RTAS plug-ins or dense automation.

DAE Error –9131 (Item #20843)

Recording to or playing from a UNIX File System (UFS) formatted drive is not supported in Pro Tools 7.0.

DAE Error –9132 (Item #32397)

If a –9132 error occurs during Bounce To Disk (even with the highest Hardware Buffer setting selected), bus the appropriate 
tracks to the appropriate number and format of audio tracks, and record to disk. You can then use the resulting audio files 
as you would have used bounced files.

DAE Error –9155

In sessions with high sample rates of 96 kHz or more, you may need to set the Hardware Buffer Size to 512 or more to avoid 
–9155 errors during playback with dense automation.

DAE Error –9735

When Pro Tools reaches the end of its time limit in the session Timeline, or if Pro Tools has been in continuous play for 
longer than the maximum time limit, you will encounter a DAE error –9735. The maximum time limit for Pro Tools depends 
on the session sample rate. For more information, see the Pro Tools Reference Guide.
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